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Introduction.

CDRoller is a powerful, easy-to-use and low-cost toolset for CD/DVD data recovery.

Powerful:  CDRoller finds, retrieves and copies the lost data from CDs and DVDs that seem to be
inaccessible for Windows standard tools. While this does not include the disks that are physically
damaged, the program will:
· Effectively retrieve the data off the discs created by "drag and drop" CD/DVD writing software, such

as well-known Roxio (Adaptec) and Ahead Nero software packages, CeQuadrat's PacketCD, Instant
Write, B's CLiP and others.

· Recover CD and DVD data created by standalone devices that record directly onto disks, including:
Sony digital cameras, Hitachi, Panasonic, Canon and Sony DVD camcorders, personal DVD
recorders, etc.

· Includes a built-in Video Splitter. Splits the recovered VOB or VRO files into a several clips (scenes),
automatically converting a "raw" DVD-video into MPEG files without loss of quality. Specially tested
on the discs, created by Hitachi DVD camcorders.

· Includes a built-in CD/DVD data burner. Burns your data onto CDs and DVDs with the most
compatible ISO/Joliet file system. There is no need to run 3-rd party CD/DVD writing sofware if you
wish to backup your files and folders immediately after recovery. The "Burn" option is integrated into
a common shell. Just write a new disc with recovered data within a couple of minutes, without
leaving CDRoller!

· Erases CD and DVD re-writable media. Support of quick and full erase methods.

· Retrieve back up files from the discs recorded in the several stages (multisession discs).
· Include a built-in UDF Reader. There is no need to install a third-party software, for example Roxio

(Adaptec) UDF Reader driver.
· Find and retrieve the lost files on UDF discs, including: accidently deleted files, files on quick-

formatted disc, files on incorrectly closed disc, etc.
· Identifies the lost files on ISO/Joliet discs with the damaged file system (volume descriptors, path

tables and directories), using the raw data only.
· Simply retrieve data from scratched, damaged or defective discs.
· Extract tracks from audio CDs
· Test CD/DVD readability

Easy-to-use: All features are integrated into a common and easy-to-use intuitive shell.

Low-cost:  A single user license costs only 34 USD.

Toolset: The program contains a set of instruments to work with different formats of CDs (DVDs) and
file systems.

CD/DVD Data Recovery:  Unfortunately, there is a lot of factors that can cause you to lose access to
the data on your disks. System or power failures, hardware problems, media and CD/DVD mastering
software problems... Often, when a disc becomes inaccessible more than a single factor has
contributed to the problem. Fortunately, many of such problems that prevent "normal" access to the
data can be bypassed when using CDRoller.
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1. Installing CDRoller.

To install CDRoller, you need at least:
· Microsoft Windows 95/98/ME/NT4/2000/XP/2003/Vista operating system
· Intel Pentium or compatible CPU

· 256 MB of RAM
· 9 MB free hard disk space
· CD/DVD drive(s). The devices with IDE or SCSI interfaces are highly recommended.

Note. You must have administrator rights to install the program under Windows NT4, Windows 2000 or
Windows XP.

There are no special considerations for installing CDRoller. It uses no .INI files, and only uses the
registry for holding installation options. It will initially use default options that will be changed further via
the user preferences.

To install CDRoller:
1. Run the installation file. The installation program displays a Welcome page similar to the one shown
here.

Click the Next button.
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2. The installation program displays a License Agreement page similar to the one shown here.

Read the license agreement displayed and if you agree to its terms click the I accept the agreement.
You must agree to terms of the license agreement to install CDRoller.
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3. The installation program displays a Destination Location page similar to the one shown here.

CDRoller consists of a number of files containing the program and help information. It is recommended
that you accept the default folder structure provided in the installation program. When you're satisfied
with the installation folder specification, click the Next button.
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4. The installation program displays a Select Start Menu Folder page similar to the one shown here.

By default, the installation program creates an CDRoller folder on your start menu. This is what you'll
see when you choose Start | Programs on the Windows taskbar. If you want to use an existing folder,
choose it from the list shown; if you want to use a different name, type it in the text field. When you're
satisfied with your start menu folder selection, click the Next button.

5. The installation program displays a Select Additional Tasks page similar to the one shown here.
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If you work with CDRoller the first time, we recommend you to read the Quick References before start
of the program. Please consult our User's Manual  to read more about specific features of CD/DVD
data recovery, for example: retrieving the data off the discs created by digital cameras, DVD
camcorders, or standalone DVD recorders.

6. The installation program displays a Ready To Install page similar to the one shown here.
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You've made all the choices necessary to begin installation. Click the Install button to begin installing
CDRoller.
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7. After the copying of files to your computer has been completed, the installation program displays a
Finish  page similar to the one shown here.

If you install CDRoller under Windows 95/98/ME, we recommend you to restart your computer. Click
the Finish button. Installation of CDRoller is complete.
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2. Uninstalling CDRoller.

To uninstall CDRoller you can either:
· Use the menu selection created for this purpose.
· Select the Add/Remove Programs applet from the Windows Control Panel.

CDRoller does not install any system DLLs and does not modify Windows in any manner. Uninstalling
this program will not affect other applications. To uninstall CDRoller, click the Start button on the
Windows Taskbar, then choose Programs | CDRoller | Uninstall CDRoller.
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3. Opening and Closing CDRoller.

Opening CDRoller.
To open the program, click the Start button on the Windows Taskbar, then choose Programs |
CDRoller | CDRoller.

Closing CDRoller.
Close CDRoller as you would any other Windows application by using the File | Exit menu item or
Alt+F4 keyboard shortcut.
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4. How to register the program.

Unregistered version does not permit copying CD/DVD objects for the purposes of recovering data -
the program checks readability of CD/DVD files, but it can not save the files to the destination drive. To
enable the full functionality you have to purchase the software and register your copy of CDRoller with
the help of your license key.

You can always order CDRoller using credit cards or another methods of payments if you visit web
page at http://www.cdroller.com/htm/purchase.html.

To register the program:
1. Open CDRoller.
2. Select Help | Register option in the Main Menu.
3. Enter your name and personal license key.
4. Click Accept button and restart CDRoller.

http://www.cdroller.com/htm/purchase.html
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5. How to upgrade CDRoller.

To upgrade CDRoller:
1. Uninstall an old version of the program.
2. Download a trial copy of CDRoller at http://www.cdroller.com/htm/download.html  and install it.
3. Register a trial copy with the help of your licence key.

Note. To upgrade your previous version of CDRoller (3, 4, 5 or 6) to CDRoller 7, you should contact
our Sales Dept at sales@cdroller.com. Please send us your personal license key, or the name and and
e-mail address that you used when purchasing the software, or any other info (your order ID, post
address, etc.) that may help us to identify your purchase status. Your request will be responded shortly,
usually within 2 to 12 hours.

http://www.cdroller.com/htm/download.html
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6. Recovering CD/DVD Data.

Overview.

The process of CD/DVD data recovery is not easy and, unfortunately, it's very hard to create a "magic"
tool can retrieve all data in all cases on all discs. In this section, we will try to give you a base
recommendations how to achieve a positive result quickly and with a high reliability. Also, you can
always receive a technical support at support@cdroller.com, all your questions regarding the problems
with CD/DVD data recovery will be responded within 2 to 24 hours.

We consider the following steps can be high-lighted:
1. Disk recognition.
2. Using Session Selector to access to all sessions on multisession disk.
3. Searching the lost UDF files on CD-R/DVD-R/DVD+R disks
4. Applying Scan UDF Disc to search for the lost objects on all types of UDF disks.
5. Recovering CD/DVD files.

Note. The 2nd...4th steps may be skipped. This depends on the disk type determined at the 1st step.

Separately, we high-light the following problems:
· Reading mini DVD-R discs created by Hitachi or Panasonic DVD Camcorders
· Recovering the files from DVD discs created by Roxio Classic Creator 6
· Retrieving the photos from mini discs created by Sony Mavica CD cameras
· Recovering video data off the discs created by DVD recorders (standalone devices)
· Reading mini DVD-R/RW discs created by Sony DVD Camcorders
· Identifying Raw ISO Data

· Recovering DVD video data using Wizard interface .
· Burning recovered files.

6.1. Disk recognition.

Open CDRoller and insert the disk into the drive. The program must analyse your CD/DVD immediately
after insertion. After the disk has been verified, the Main Window displayes it similar to the one shown
here.
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Look at the File System column. This may give us an important info about the type of the disk. In the
picture shown above, this is a disk in which UDF file system has been placed onto a single session.
We will name the disk has one or more such sessions as "UDF disk ". If all sessions are displayed
with "ISO/Joliet" in the File System column, we will name such disk as "ISO disk", i.e the disk with ISO
9660 file system.

At first, click the Recover All button in the Toolbar in order to retrieve all files and folders off the disc or
selected (current) session. Also, check out a readability of the root directory (folder), just left double
click on the disk name, or use the Open command from the Side Bar. Please answer to the following
questions: Is the root folder readable or not? Can i browse the disk contents? The answers may be
applicable at the next stages of cd/dvd data recovery.

Troubleshootings.
1. If the program can not recognize your disk automatically, click the Refresh button in the Tool Bar, or
insert the disk first and then open CDRoller. Also, to read the unclosed disks, i.e the disks left "as-is"
by CD/DVD mastering program we recommend you to use the following method:
· Uncheck Detect disc insertion by Windows under the Browser tab in the Preferences dialog and

wait for the end of disk reading processed by another CD related program.
· Select the Refresh command from the File  menu, or click the Refresh button in the Tool Bar.

2. To read UDF disks we recommend you to use CD-RW (DVD-) drives - the disks are recorded with
so-called packet-written technology and old CD-ROM / DVD-ROM drives may not access to their data.

3. Some drives may not support our special methods. These devices may hang the program when
analyzing the disk. In this case, uncheck Always use a drive capabilities under the Browser tab in
the Preferences dialog, insert the disk and try to recognize it again.

4. If you get 'Unknown file system...' message and you're sure the files data were placed on the disc,
please try to scan your disc without using the file system structures:

- If you know ISO/Joliet file system was actually placed on the disc, try the Identify Raw ISO Data
command.

- In case of UDF disc, if you know a name of CD/DVD mastering program (or standalone device),
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which actually created your disc, try the forced scan, selecting the software or device profile in the
forced scan list under the UDF Reader tab in the Preferences dialog.

6.2. Using Session Selector.

We often receive the emails similar to the following one:
"I have copied back up files to a CDR in several stages, but the last time I backed up, I was only able
to see the most recent batch of files. The others seem to have disappeared... I presume they are still
there on the CD but "hidden" in some way - may be a different volume ?"

Fortunately, CDRoller offers the tool named as "Session Selector" to access to the data placed into
different sessions (volumes) on your CD-R/DVD-R. These disks are known as multisession
CD/DVDs. By default, CDRoller displayes contents of the most recent session.

To select a new session, just click a new item with 'Disc Session' type in the main program window.
Then, try to apply the Recover All command, or simply Open  a new session. Probably, you will detect
a new files that have been "hidden" before.

Note. Recover All retrieves all files from the selected (current) session only.

Hint.
Sessions Selector  may be also extremely useful if the root folder of the last session seems to be
unreadable at the "Disk recognition" stage, but some important files may be located (duplicated) in
the previous session(s).
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6.3. Searching the lost UDF files on CD-R/DVD-R/DVD+R disks.

A correct reading of UDF files and folders on write-once media (CD-R/DVD-R/DVD+R) is provided by
Virtual Allocation Table (VAT). Each time, when you add, change or delete files on CD-R/DVD-
R/DVD+R media, UDF mastering program creates a new VAT that reflects a new state of your disk. A
new VAT is being placed on the disk physically, when you eject the disk from CD/DVD drive.  VAT's
location is crucial for the disks created with the help of drag & drop software, such as well-known Roxio
(Adaptec) DirectCD and Drag-To-Disc. If the VAT can not be found or is corrupted, files will be
missing.

If your CD-R/DVD-R/DVD+R is recognized as UDF one, but when you try to open the disk, you get the
error message about unreadable root folder - this means the last VAT is not found. Also, if you have
accidently deleted some files, a new VAT does not point to them. To recover the deleted files, you
should use the previous VATs.

There are two main ways to find the lost files:
1. Using Scan UDF Disc from the Tools menu.
2. Searching an old VATs in order to recover the files from the previous backups.

The first method is described in the section 6.4. To search all VATs, please do the following:
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Check

on the 'Search of all VATs' box on the UDF Reader tab in the Preferences dialog. Click the OK
button to close the Preferences.

· Click the Refresh button in the Tool Bar. After a while the program will display a progress dialog
similar to the one shown here:

· when the process is completed, you should see the confirmation message:

· Click the OK buttons in this and all further dialogs. The program considers an each backup as a
separate "session". When you will see a new disk image (icon) in the program window, please use
built-in Session Selector (see the section 6.2) for access to all backups.

Note. Please do not search all VATs on the following disks:
- CD-RW/DVD-RW/DVD+RW,
- DVD-R and DVD+R created by DVD personal recorder (standalone device) and DVD camcorder.
These disks do not contain VAT at all.
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6.4. Applying Scan UDF Disc.

In addition to another methods of CD/DVD data recovery, Scan UDF Disc gives you a good chance to
retrieve several types of files, including:
· Files are not visible in Windows Explorer - the writing process was interrupted by a system or

power failure before UDF folders were placed on the disc, but most or all of the files were written to
the disk. This means that the files may be on the CD (DVD), but Windows Explorer cannot see them.

· Lost files - complete files that do not have a file name associated with them. They can also be files
that you accidently deleted from the CD (DVD).

· Files on the disks quick-formatted by Roxio DirectCD and Nero InCD.
· Files located in unreadable (damaged) UDF folders , including the root one.
· Files located on Sony Mavica CD finalized with failure on the camera.

To start Scan UDF Disc select the same option in the Tools menu or in the Side Bar. The program
displays a progress dialog similar to the one shown here.

After CD/DVD scan is completed or canceled, found files and/or folders are displayed in the Lost
objects detected on disc... window similar to the one shown here

You can rename the selected folders, open them with the help of Open command, or left double
clicking on their names. If the lost folders have been found, try to open them first. This may give you a
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chance to recover the files with original names that are located in the found folders.

When applying the Recover All / Recover Selected commands, the program automatically identifies
the types of files, initially shown as FileXXXX ones, or the files having an intermediate extensions, such
as .ole2 for MS Office ones.

If you know an original type, you can rename the selected files manually, with the help of Rename
command, or/and use New Extension option to speed up the re-naming process in case of the large
list.

Hints and Tips.
If you're going to retrieve UDF files from the same disc at the different times, you can save the table of
contents (names,locations, attributes) of the found files into separate file by Save Table Of Contents
command from the File menu. Further, check on the Load Table Of Contents from file box on the
UDF Reader tab in the Preferences dialog. Next time, when you will run Scan UDF Disc the program
will display the list of the found objects shortly, without scanning the disc, and you can continue to
retrieve the files data.

Trouble Shooting.
If the program can not recognize UDF disk, but you are certainly sure the disk contains the files, we
recommend you to try the forced scan of the disk. This may be useful if the disk was incorrectly
finalized, and the system data are not accessible. For example, this problem often occures on Sony
Mavica CD when the finalization step failed on the camera.

To start the forced scan, you should initially know what CD/DVD mastering program (or device)
formatted your disk. For example: Roxio (Adaptec) DirectCD, Nero InCD, PacketCD or Sony Mavica
CD digital camera. Further, you should assign an appropriate profile in the Forced scan list under the
UDF Reader tab in the Preferences dialog and click the Refresh button in the Tool Bar.

Note.
Obviously, there is no 100% guarantee to recover all displayed files completely, please keep in mind,
that some files may be erased or partially re-written by a new ones. The program can restore those
FILES DATA, which else it is possible to rescue.

6.5. Recovering files.

To recover the found files and folders, you can use Recover All and Recover Selected options, or
simply drag and drop selected items to the destination you have chosen on your HDD.

When selecting Recover All / Recover Selected options, the program displays a Data Recovery
dialog  similar to the one shown here.

Key Features.



6. Recovering CD/DVD Data. 21

© 2003 - 2007 Digital Atlantic Corp.

· Saves recovered data into intermediate file. Further, a recovery of the selected file can be
continued with the help of Resume Recovery option in the program window.

· Displays the current results (recovery details).

· Saves recovery results (report) into HTML file.
· Changes a recovery settings, without leaving the process.
· Skips file during the recovery process, if you decide a file isn't so important.

6.6. Reading mini DVD-R discs created by Hitachi or Panasonic
DVD camcorders.

6.6.1. Basic recommendations.
· We strongly recommend to use DVD-RW drives ("dvd writers"). DVD-ROM drives ("dvd readers")

often can not access to the "troubled" or non-finalized DVD discs.
· You should uncheck the Detect disc insertion by Windows and Always use a drive capabilities

boxes under the Browser tab in the Preferences dialog before you will insert the troubled disc into
the drive.

· First, we strongly recommend to try the Recover DVD Video option. In addition, you can try to read
the "troubled" discs, using a different settings under UDF Reader tab in the Preferences dialog
(Chapters 6.6.2 and 6.6.3).

6.6.2. Reading non-finalized (open) DVD-R disc.
Symptom.
Disc was not finalized, you lost an access to the data due to Disk Error message when you turned on
the camera.
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows and Always use a drive capabilities boxes are
UNCHECKED on the Browser tab in the Preferences dialog. Click the OK button to close the
Preferences.

· Insert the troubled DVD-R.
· Click the Preferences again. Set the Forced scan to Hitachi DVD-R (O) on the UDF reader tab.

Click the OK button and close the Preferences again.
· Click the Refresh button in the Tool Bar. Do you see the VTS_01_1.VOB file in the Lost objects

detected... window? If yes, go to the step 6.6.4.

6.6.3. Reading DVD-R disc that was finalized with error.
Symptom.
The disc finalization was accidently interrupted, for example, due to the power failure.
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows and Always use a drive capabilities boxes are
UNCHECKED on the Browser tab in the Preferences dialog. Click the OK button to close the
Preferences.

· Insert the troubled DVD-R.
· Click the Preferences again. Set the Forced scan to Hitachi DVD-R (F)  on the UDF reader tab.

Click the OK button and close the Preferences again.
· Click the Refresh button in the Tool Bar. Does the program scan your disc? Are any files found

within the first 100..200 sectors? If yes, try to select and rename the largest file to the .vob one with
the help of Rename option in the Tool Bar and go to the step 6.6.4.
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6.6.4. Recovering the found VOB files.
Select the VOB file(s) and apply the Recover Selected command. If a recovery process seems to be
stalled ("frozen"), please click the Save Recovered button in the Data Recovery window.. When
recovering, you can assign a new settings in the Data Recovery window, for example, selecting the
Fill sector by zeroes in the Overread list.

6.6.5 Viewing the VOB files.
To view the VOB files, we recommend PowerDVD from CyberLink at http://www.gocyberlink.com/.

6.6.6. Creating a new DVD with recovered video .

6.7. Recovering files from DVD discs created by Roxio Classic
Creator 6.

Symptom. The files and folders only from the first session (backup) seem to be shown on the DVD disc
(DVD-R, DVD+R, DVD-RW, DVD+RW) created by Roxio Easy Creator Classic 6.

Cause & Troubleshooting.
If you have not changed the default settings in the Project Properties, Easy Creator Classic (EZ
Classic) writes the both UDF and ISO (Joliet) file systems on the DVD discs. Unfortunately, probably
due to the bug,  EZ Classic hides a new files in UDF folders, but always shows them in ISO/Joliet ones.
A solution is the following:
· Run CDRoller without any discs inserted.
· Click the Preferences button in the Tool Bar and check on Read only ISO 9660 tracks box on the

Browser tab in the Preferences dialog. Click the OK button to close the Preferences.
· Insert the DVD into the drive and click the Refresh button in the Tool Bar. Only ISO/Joliet files and

folders will be shown.
· If the disc contains a several sessions, use the built-in Session Selector.

6.8. Retrieving the photos from mini discs created by Sony
Mavica CD cameras.

6.8.1. General requirements and settings.
· CD-RW or DVD-RW drives (cd or dvd "writers") are more preferable in comparing with CD-ROM or

DVD-ROM drives (cd or dvd "readers").
· You should uncheck the Detect disc insertion by Windows box on the Browser tab in the

Preferences dialog before you will insert the troubled disc into the drive.

6.8.2. Reading mini disc that was finalized with failure on the camera.
Symptom.
The disc finalization was accidently interrupted, for example, due to the power failure.
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows is UNCHECKED on the Browser tab in the
Preferences dialog. Click the OK button to close the Preferences.

· Insert the troubled disc.
· Click the Refresh button in the Tool Bar.
· Does the program recognize your disc? If not, please go to the step 6.8.3
· If you can see the disc icon in the program window, try to open the disc by left-double clicking its

name. Do you get the message about unreadable root folder? If yes, try to run Scan UDF Disc from
the Tools menu and go to the step 6.8.4 if the program has found the lost files.

http://www.gocyberlink.com/
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6.8.3. Reading non-finalized (open) disc.
Symptom.
Disc was not finalized, you lost an access to the data due to Disk Error. You was able to view the
photos earlier (prior to the disk error).
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows  box is UNCHECKED on the Browser tab in the
Preferences dialog. Click the OK button to close the Preferences.

· Insert the troubled disc.
· Click the Preferences again. Select Sony Mavica (O) in the Forced scan list under the UDF reader

tab. Click the OK button and close the Preferences again.
· Click the Refresh button in the Tool Bar. If dialog with Step 1. Specify your scan area caption

appears, try to find and recover the lost photos step-by-step, using Wizard interface. Otherwise, the
program tries to find the lost files, scanning "UDF partition". Are any files found? If yes, go to the step
6.8.4.

6.8.4. Recovering the found (indexed) files displayed in the "Lost objects detected..." window.
· Apply Recover All / Recover  selected to retrieve the found files (photos) automatically.
· To view the found photos (JPEG files), you can use View Image option. Just select a JPEG file and

click the View Image in the Side Bar (left panel of the "Lost objects detected..." window).
· Select file(s) and use Rename or/and New Extension commands to re-name the indexed files to

.jpg ones, and then copy them to HDD with the help of Recover selected or drag&drop operations.

6.9. Recovering video data off the discs created by DVD
recorders (standalone devices).

6.9.1. Basic recommendations.
· We strongly recommend to use DVD-RW drives ("dvd writers"). DVD-ROM drives ("dvd readers")

often can not access to the "troubled" or non-finalized DVD discs.
· You should uncheck the Detect disc insertion by Windows and Always use a drive capabilities

boxes under the Browser tab in the Preferences dialog before you will insert the troubled disc into
the drive.

· First, we strongly recommend to try the Recover DVD Video option. In addition, you can try to read
the "troubled" discs, using a different settings under UDF Reader tab in the Preferences dialog
(Chapters 6.9.2 and 6.9.3).

6.9.2. Reading non-finalized (open) disc.
Symptom.
Disc was not finalized at all, you lost an access to the video data when you turned on the recorder.
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows and Always use a drive capabilities boxes are
UNCHECKED under the Browser tab in the Preferences dialog. Click the OK button to close the
Preferences.

· Insert the troubled disc.
· Click the Preferences again. Set the Forced scan to Rec DVD+RW (O) (in case of DVD+RW disc

created by Thomson RCA, Philips, etc), or LiteOn DVD+R (O) or Sanyo DVD+R (O) (if the DVD+R
disc was created by Lite-On or Sanyo DVD recorder) under the UDF reader tab. Click the OK button
and close the Preferences again.

· Click the Refresh button in the Tool Bar. The Lost objects detected... window must appear
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immediately. Do you see the VTS_01_1.VOB file? If yes, go to the step 6.9.5.

6.9.3. Reading the disc was finalized with error.
Symptom.
The disc finalization was accidently interrupted, for example, due to the power failure.
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows and Always use a drive capabilities boxes are
UNCHECKED under the Browser tab in the Preferences dialog. Click the OK button to close the
Preferences.

· Insert the troubled DVD.
· Click the Preferences again. Set the Forced scan to Rec DVD+RW (F) (in case of DVD+RW disc

created by Thomson RCA, Philips, etc), or LiteOn DVD+R or Sanyo DVD+R (F) (if the DVD+R disc
was created by Lite-On or Sanyo DVD recorder) under the UDF reader tab. Click the OK button and
close the Preferences again.

· Click the Refresh button in the Tool Bar. Does the program scan your disc? Are any files found
within the first 100..200 sectors? If yes, try to select and rename the largest file(s) to the .vob
one(s) with the help of Rename or/ and New Extension options and go to the step 6.9.5.

6.9.4. Reading quick-erased DVD-RAM disc.
Symptom.
Disc was accidently quick-erased by DVD-RAM recorder. All movies seem to be lost.
Troubleshooting.
· Do not record any new movies.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows and Always use a drive capabilities boxes are
UNCHECKED under the Browser tab in the Preferences dialog. Click the OK button to close the
Preferences.

· Insert the troubled disc.
· Click the Preferences again. Set the Forced scan to Rec DVD-RAM (E) under the UDF reader tab.

Click the OK button and close the Preferences again.
· Click the Refresh button in the Tool Bar. The Lost objects detected... window must appear

immediately. Do you see the VTS_01_1.VOB file? If yes, go to the step 6.9.5.

Note. This feature was tested on the discs erased by Panasonic DVD-RAM recorder only. If you have
any questions, please contact our Support Dept. at support@cdroller.com

6.9.5. Recovering the found VOB files.
Select the VOB file(s) and apply Recover Selected command. In case of non-finalized (open) disc
(6.9.2) or quick-erased DVD-RAM (6.9.4), an actual length of the lost video data is unknown. If a
recovery process seems to be stalled ("frozen"), please click the Save Recovered button in the
Data Recovery window. Also, when recovering the files, you can assign a new settings in the Data
Recovery window, for example, selecting the Fill sector by zeroes in the Overread list.

6.9.6. Viewing the VOB files.
To view the VOB files, we recommend PowerDVD from CyberLink at http://www.gocyberlink.com/.

6.9.7. Creating a new DVD with recovered video .

http://www.gocyberlink.com/
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6.10. Reading mini DVD-R/RW discs created by Sony DVD
Camcorders.

6.10.1. Basic recommendations.
· We strongly recommend to use DVD-RW drives ("dvd writers"). DVD-ROM drives ("dvd readers")

often can not access to the "troubled" or non-finalized DVD discs.
· You should uncheck the Detect disc insertion by Windows and Always use a drive capabilities

boxes under the Browser tab in the Preferences dialog before you will insert the troubled disc into
the drive.

· First, we strongly recommend to try the Recover DVD Video option. In addition, you can try to read
the "troubled" discs, using a different settings under UDF Reader tab in the Preferences dialog
(Chapter 6.10.2).

6.10.2. Reading non-finalized (open) DVD-R/RW disc.
Symptom.
Disc was not finalized by your Sony DVD camcorder.
Troubleshooting.
· Remove any disks from your CD/DVD drive(s).
· Run CDRoller.
· Click the Preferences button in the Tool Bar or select the same option from the View menu. Make

sure that the Detect disc insertion by Windows and Always use a drive capabilities boxes are
UNCHECKED under the Browser tab in the Preferences dialog. Click the OK button to close the
Preferences.

· Insert the non-finalized DVD-R or DVD-RW into the drive.
· Click the Preferences again. Set the Forced scan to Sony DVD-R (O),  Sony DVD-RW (O), or

Sony DVD201-RW under the UDF reader tab. Click the OK button and close the Preferences again.
· Click the Refresh button in the Tool Bar. Do you see some VTS_01_XX.VOB files in the Lost

objects detected... window? If yes, go to the step 6.10.3.

Note. Each displayed VOB file can contain a few video clips

6.10.3. Recovering the found VOB files.
Select the file(s) and apply Recover Selected command. If a recovery process seems to be stalled
("frozen"), please click the Save Recovered button in the Data Recovery window. Also, when
recovering the files, you can assign a new settings in the Data Recovery  window, for example,
selecting the Fill sector by zeroes in the Overread list.

6.10.4. Viewing the VOB files.
To view the VOB files, we recommend PowerDVD from CyberLink at http://www.gocyberlink.com/.

6.10.5. Creating a new DVD with recovered video .

6.11. Identifying Raw ISO Data

In addition to another methods of CD/DVD data recovery, Raw ISO Data Identifier gives you a good
chance to find and retrieve the lost files from the troubled discs, created by Ahead Nero Burning ROM,
Adaptec (Roxio) Easy CD/DVD Creator, Sonic software and other programs, including:
- CDs and DVDs with currently unreadable system area (so-called Primary and Secondary ISO
Volume Descriptors). When trying to recognize these discs the first time, CDRoller generates
"Unknown file system..." error message.
- Discs with the damaged and corrupted folders .
- UDF Discs having ISO-alike files locations.

Note. Please use this option only if another methods of CD/DVD data recovery have not given an effect

http://www.gocyberlink.com/
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before.

To start Raw ISO Data Identifier, please select the Identify Raw ISO Data option from the Tools
menu, or Side Bar. The program scans the disc and tries to find and identify the files on the track of
"raw" CD/DVD sectors, without using the ISO/Joliet File System structures. After a process is
completed or canceled, a found files are displayed in the Lost objects detected ... window similar to
the one shown here

First, try to Recover All or Selected files. These commands also allow to complete an identification of
files that have not been preliminary identified on the scan stage, or have an intermediate extensions.
For example, .ole2 for MS Office files. If you know an actual file name, you can Rename the selected
file manually, or/and use New Extension command to speed the re-naming process in case of the
large list of one-type files.

6.12. Recovering DVD video data using Wizard interface.

CDRoller Wizard interface is designed for novice users and allows to recover DVD videos and photos
off the discs, created by standalone devices (camcorders, personal DVD recorders), using the simple
"step by step" procedure. To display the Wizard dialog, just select the Recover DVD Video option from
the File Menu.

Every Wizard dialog contains a brief instructions, describing a possible user actions in order to achieve
the best results in DVD data recovery.

At the 1st step, please select your computer DVD drive. We recommend to use the computer DVD-RW
drives (dvd writers) in order to read non-finalized or "troubled" DVD discs.
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At the 2nd step, just insert your DVD and click the Next button.

At the 3rd step, please select DVD video recorder (camcorder or standalone dvd recorder) that placed
a video or/and photos on your disc. You can use Any recorder  setting and try to scan each of
displayed tracks, starting on the track with the highest length.
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At the 4th step, just click the Next button if you scan the selected area for the first time.

At the next step, you should see a dialog similar to the one shown here.
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Finally, just recover the found video (VOB files). You can also try to scan another track, shown at the
3rd step.

Note. To view the VOB files, we recommend PowerDVD from CyberLink at
http://www.gocyberlink.com/.

6.12.1. Creating a new DVD with recovered video.

Split video  option splits a recovered VOB or VRO files into a several clips (scenes), automatically
converting a "raw" DVD-video data into MPEG files without loss of quality. In contrast to VOB files,
MPEG files can be simply viewed with the help of any DVD-compatible software (player) and also can
be loaded into your DVD-authoring software, for example: Sonic MyDVD, Nero Vision, etc.

http://www.gocyberlink.com/
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Before splitting, you should recover the found VOB or VRO files off DVD, for example with the help of
Recover All or Recover Selected commands. Further, just select VOB or VRO file in the CDRoller
window again, click the Split Video  in the Side Bar (left panel of the window where you see the file)
and assign the recovered file name in the next dialog. Or, just click the Split Video button in the
Main ToolBar.

6.13 Burning recovered files.

CDRoller Wizard interface allows to burn CD/DVD data, using a simple "step by step" procedure. To
display the Wizard dialog, just click the Burn  button in the Main ToolBar  or select the same option from
File Menu.

At the 1st step, please select your burner (computer CD or DVD drive) and click the Next button. The
displayed drive features can help you to determine whether the selected device supports the type of
CD or DVD media you want to burn. For example, do not try to burn DVD discs, using CD-RW drive.

At the 2nd step, just insert a new (blank) disc and click the Next button. For multisession disc, you can
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select a prior session to be included into a current compilation.

At the 3rd step, please add files or/and folders into your current compilation and click the Next button.
You can use Add button, or just drag files and folders from the Windows Explorer. To edit a current
compilation, please use Delete and Rename options for the selected item(s).

At the 4th step, you can edit disc (session) name, assign writing speed and choose - whether you will
add a new files on the same disc later or not.  To start a burn process, just click the Burn! button.
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Finally, you should see "Burning disc ..." dialog similar to the one shown here.

Notes.
1. We do not recommend to try to place a new files onto your "troubled" discs. Also, please do not try
to close these discs, hoping to make them readable for Windows. The most safe way is to recover your
files from the "troubled" disc to Hard Disk Drive (HDD) first, and then place (write) them onto a new
blank disc.
2. To erase your re-writable disc, just click the Erase button in the Main ToolBar or use the same
option from File Menu.
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7. Additional features.

Overview.

· In addition to CD/DVD data recovery the program offers set of features for:
· Testing Disc
· Extracting Audio Tracks
· Extracting ISO Image File
· Creating Short CD/DVD Image

All mentioned features are integrated into a common intuitive shell of CDRoller.

7.1. Testing disc.

With the help of Disc Test, you can check if a CD or DVD contains errors. It can be useful to:
- Check the quality of the CD/DVD media.
- If you have a CD/DVD recorder, you can check whether the data (files and folders) on the CD/DVD-
R(W) is written correctly.
- Get advanced information from the Disc Volume.
The test can be used for both CD-ROM and CD-Audio. It also examines Multisession and Mixed mode
discs.

The list of tests includes ISO 9660 File System test, Disc Surface test and Digital Audio Extraction
(DAE) Quality test.  Since the program automatically determines the disc type, it always knows what
the test from the list can be applied to the CD/DVD inserted into the drive. By Disc Test options, you
can manually include (exclude) an appropriate test to (from) the list, set scan ratio while testing
CD/DVD surface and also select checks of all sessions or only current session on multisession disc.

We recommend you to run the disc test periodically on the discs with ISO/Joliet file systems, in order to
make sure a valuable files were really ("physically") placed on the disc, particularly in the following
situations:
- if your DVD was created by Nero Burning ROM.
- if your CD with photos was burnt from memory cards.

To start the disc test, please select the Test Disc option in the Tools menu. The program displays a
progress dialog similar to the one shown here.

After all tests have completed, the program generates the report(s). An example of ISO/Joliet File
System report is shown here.
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Note. The Disc Test is not available for the UDF disks.

7.2. Extracting Audio Tracks.

To extract ("rip") audio track(s):
1. Insert CD audio into the drive.
2. After disk recognition left double click on CD name in the Main Window. The program displays the
Main Window similar to the one shown here.
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3. Select the track(s).
4. Click the Recover Selected command in the Side Bar, or simply drag and drop selected track(s) to
the destination on HDD.
5. The program displays a progress dialog similar to the one shown here.

To extract audio tracks the program utilize the method known as Digital Audio Extraction (DAE). Key
features:
· Applies a set of different extraction methods with Dynamic, Fixed synchronization with "jitter"

correction, re-read block of sectors in case of error or/and lost of synchronization.
· Autodetects an appropriate read function for CD drive.
· Supports WAV, MP3, MP2, OGG or RAW formats of output file.

· Supports Windows ACM (Windows Audio Compression Manager).
· Supports Lame and Blade MP3 encoders (DLLs) and Ogg Vorbis, high-quality and patent-free audio

codec.
· Extracts audio tracks "on-the-fly", directly to the output file without creating an intermediate WAV file.
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Hint.
To change default settings (select another encoder, extraction method, etc.) use Audio Extraction tab
in the Preferences dialog.

7.3. Extracting ISO Image File.

IS0 Image is a single large file that is a representation of the whole set of data and programs as it will
appear on a CD or DVD. A disc image refers to both content and logical format. It can be useful to:
· Replicate your CD (DVD) further using CD/DVD mastering programs such as Adaptec Easy CD

Creator, Nero Burning ROM, Goldenhawk CDRWin, etc.
· Write the disc image to hard drive once, then record it several times to different CDs (DVDs) to save

processing time.

· Create a disc image file to be written to CD (DVD) on another system (UNIX, Macintosh).
· Back up CD/DVD data.

To extract ISO Image File:
1. Insert the disc into the drive.
2. After disk recognition select Tools | Extract to ISO Image File option.
3. The program displays a progress dialog similar to the one shown here.

Key Features.
· Saves recovered data into intermediate file. Further, you can continue to Extract ISO Image File

with the help of Resume Recovery option in the program window.
· Displays the current results (recovery details).
· Saves recovery results (report) into HTML file.
· Changes a recovery settings, without leaving the process.

Note. ISO image file can be created only if the disk with a single data track originally was created
using ISO-9660 or Joliet format. UDF disks, such as those created with DirectCD, Nero InCD and
PacketCD, cannot be copied in this manner.

7.4. Creating Short CD/DVD Image.

The Short CD/DVD Image is a file that contains ALL DIRECTORY STRUCTURE (directory tree) of the
disk, including complete folders and files names with attributes. This enables you to browse through
the folders, search for the files or/and folders which you need (with the help of Tools | Find  option),
detect the prorerties of them, using the Properties command, but in order to retrieve any file, you
should insert a "real" CD or DVD. When you insert a disc that has the image that has been created
before, CDRoller determines this image as a "mirror" of the real CD(DVD), displays it with an
appropriate icon in the Main window and further, utilizes image to access to any folder quickly without
reading of inserted CD(DVD). This is an extremely useful if your "real" CD (DVD) has become a disc
with unreadable folder(s)  and, therefore you can not access to its files.
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To create Short CD/DVD Image:
1. Insert CD or DVD into the drive.
2. Select Tools | Short CD/DVD Image option.

You can create the image with CD (DVD) name (label) or manually assign a new name for each
inserted disk. In case of multisession disc, you can create CD/DVD image for each session. All
CD/DVD images automatically are placed into a separate directory assigned under the
CD/DVD Library tab in the Preferences dialog.



CDRoller - User's Manual38

© 2003 - 2007 Digital At lant ic  Corp.

8. Contacting Technical Support.

The goal of the CDRoller Support Team is to provide our users unrivaled technical assistance when
implementing CDRoller technologies. Our commitment to you is very simple. Top-notch support and
immediate solutions to your technical problems. Since we have customers throughout the globe, we
will do our best to respond to requests 24 hours a day. In fact, our support staff works staggered shifts
for just this purpose.

You do not have to purchase the software in order to receive support, all your questions
regarding CDRoller will be responded within 2 to 24 hours.

If you have purchased the product, please include the email address that you used when purchasing
the software - we use this to confirm your purchase status and support requests from customers
receive priority over others.

You can contact our support department via email at: support@cdroller.com. To be notified about new
versions of CDRoller and new products please subscribe to our mailing list at http://www.cdroller.com .
All questions regarding orders, licenses or other services should be directed to sales@cdroller.com. If
you have any suggestions or comments regarding CDRoller, we'd like to hear from you. Please feel
free to send an e-mail to suggest@cdroller.com . All suggestions will be at least considered and you will
probably see them as new program's features in the future releases. If you have any problem with our
web site at http://www.cdroller.com, please do not hesitate to contact our webmasterer at
webmaster@cdroller.com.

http://www.cdroller.com
http://www.cdroller.com
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Annex A   Controls and dialog boxes.

A.1. Main Window.

The main program window consists of List Window, Status Bar at the bottom, Side Bar at the left,
List of available folders, Tool Bar and Main Menu on the top.

The List Window displays the disc contents as main folder containing drives, discs, sub-folders, files or
audio tracks. A graphic symbol, or icon associates with every folder, file or audio track. CDRoller
assigns a proprietary icon to each type of CD/DVD media: CDROM, CD-R, CD-RW have the icon as

, all types of DVD media -  icon, CD-DA (Audio CD) is displayed with  icon, symbol as

 associates with Mixed CD (data plus audio) and empty drive (drive without any disc) has the icon

as  . Short CD/DVD image has appropriate icon as   , and the icon as   is assigned to the
image that is the "mirror" of inserted disc.

To select an item in the List Window, click on its icon or name. If you want to work with multiple items
in a folder, you can select (mark) each of them, using the check box near an each item. The total size
of selected files is diplayed by the status bar. To select all items in the current folder, or return to the
prior level in the directory structure, you may also use an options from the secondary Tool Bar.

Side Bar similar to Microsoft Outlook offers an intuitive list of commands depending on your situation
(disc type, file system, data recovery problems, etc.).

To adjust a column's width, you may move the mouse pointer to the right border of the column heading
box. The mouse pointer changes to a double-headed horizontal arrow with a vertical bar in the middle.
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That means you move the border. Hold down the mouse bottom and drag the border left or right as
needed. When the border is in its preferred location, release the mouse button.

Every item displayed in the List Window has its own Pop-up menu - if you right-click on it, a menu will
show up by it, displaying all the options available over the selected item.

All buttons on the Toolbar and Side Bar have a hint - if you don't know what the button does, just
place the mouse over it and wait for a second, and a short description will appear.

CDRoller supports drag-and-drop - meaning that any file and/or folder can be copied to desired
location on HDD, or any audio track can be extracted to the output file by drag-and-drop.
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A.2. Main Menu Commands.

A.2.1. File Menu (shortcut Alt + F)

Command Shortcut Description

Open Ctrl + O Opens current (selected) disc, session, folder or file.

Recover All F9 Recovers all available objects.

Recover DVD Video F7 Runs video data recovery using the wizard interface.

Split Video Ctrl + S Converts a recovered video into MPEG files.

Refresh F5 Causes all discs in all drives to be examined.

Properties - Displays properties of the selected object(s).

Burn Ctrl + B Runs CD/DVD burning process.

Erase F11 Erases re-writable disc.

Exit Alt + F4 Ends your CDRoller session.

A.2.2. View Menu (shortcut : Alt + V)

Command Shortcut Description

Side Bar - Shows/Hides Side Bar.

Status Bar - Shows/Hides Status Bar.

Tool Bar Icons Size - Selects a size of icons in the Tool Bar (Small or
Large).

Vertical Lines - Shows/Hides the vertical lines.

Horizontal Lines - Shows/Hides the horizontal line below every item in
the window.

Highlight Full Row - If Checked, the whole line will have the selection or
the focus rectangle around it. If Unchecked, only
item's main text will be highlighted.

Sort By - Controls the sequence or order of the folder contents
by Name, Type, Size, Date or in Reverse Order.

Preferences Ctrl + P Sets up program options.

A.2.3. Tools Menu  (shortcut : Alt + T)
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Command Shortcut Description

Find F3 Activates the Search Window to search contents of
the inserted discs and also in the collection of
previously created Short CD/DVD Images.

Short CD/DVD Image Ctrl + I Creates and adds a new CD/DVD image to the
library.

Test Disc Ctrl + T Runs Disc Test.

Extract To ISO Image
File

Ctrl + E Creates ISO 9660 Image File.

Scan UDF Disc Ctrl + U Runs Scan UDF Disc

Identify Raw ISO Data Ctrl + R Runs search and identification of ISO files, without
using a system and directories structures.

A.2.4. Help Menu  (shortcut : Alt + H)

Command Shortcut Description

Contents F1 Opens the CDRoller online help.

Ordering Information - Displays information about ordering CDRoller.

FAQs - Displays Frequently Asked Questions (FAQs) with
answers about CDRoller.

Technical Support - Displays information about technical assistance.

Home Page - Visits the CDRoller web page.

About CDRoller - Displays copyright notice and enables you to
register.

A.3. The Toolbars.

A.3.1. Main ToolBar.

The buttons of the Main ToolBar duplicate the corresponding options in the File, View and Tools menu.

A.3.2. Secondary ToolBar.

Up One Level button returns focus to the parent item, usually to the parent folder (opens the folder of
the higher level) that contains current folder.
Select All selects all items (files, sub-folders or audio tracks) in the current folder.
Deselect All unselects all items (files, sub-folders or audio tracks) in the current folder.
Show/Hides files checkboxes shows/hides checkboxes near each file or folder.
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A.4. Preferences

A.4.1. Browser

Hardware Access Method (default value is: CDRoller proprietary driver for Windows 9x/ME or
Windows NT native access for Windows NT4/2000/XP)
Detects one of two methods to access hardware. We strongly recommend you using default settings,
and select  ASPI mode only if you have a serious problems with base method.
Note. This option sets the fundamental mode of application operating.To apply new setting you should
restart the program.

Date Format (default value Short Form)
Sets the Date format used by the program to display the Date information.

Time Format (default value Short Form)
Sets the Time format used by the program to display the Time information.

Treat KByte as: (default value 1024 bytes)
Detects the way of 'kilobyte consideration' as 1024 bytes exactly (in 1024 bytes mode) or as 1000
bytes (in 1000 bytes mode). It may be useful for correct file (folders or audio tracks) size calculation,
before these items will be sent to hard disk.

Search of the lost data track (default value Checked)
If Checked , the program searches the lost data track when a new disc is inserted or after Refresh
command, and, if found, displays its contents in the List Window.

Detect disc insertion by Windows (default value Checked)
If Checked the program detects arrival or removal of the CD (DVD) using Windows "standard" tools
(messages). This starts disc recognition automatically, without requirement of the refresh. If the
program can not recognize your disc automatically, try to uncheck this option and repeat examination
of a new disc by clicking the Refresh button in the Tool Bar.
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Read damaged sectors "as is" (default value Unchecked)
If Checked , when reading system area and folders, unreadable sectors will be accepted "as-is".  This
may be useful in some circumstances, but it should be understood that the content of these "accepted"
sectors could be all zero or partially correct data – there is no way to tell. You should use this mode
only if the program can not "recognize" your damaged CD/DVD or you vitally need an access to the
unreadable folder. Please keep in mind that your CD/DVD drive may not support reading of disk sector
"as is" or the content of that sector may be denied by the further checks in compliance with ISO 9660
and UDF requirements.

Read only ISO 9660 data tracks  (default value Unchecked)
If Checked, the program searches and verifies only ISO system area on data tracks after insertion of
new disc. Discs with another file system, such as UDF, require additional recovery procedures that
may take a some time, especially while reading multisession ones. If you are sure that your disc is
actually recorded in ISO 9660 format, you should check on this option in order to accelerate the disc
recognition. Obviously, to read the discs with UDF file system, this option has to be unchecked

Always use a drive capabilities (default value Checked)
If Checked, when reading the damaged sectors, the program will apply some low-level methods and
algorithms based on the capabilities of your CD (DVD) drive. In some circumstances the drive can slow
the process when meeting a bad zones (unreadable sectors). In this case we recommend you to
uncheck this option.

Display deleted files and folders (default value Checked)
If Checked, the program displays files and folders having deleted characteristics on CD-RW/DVD-
RW/DVD+RW/DVD-RAM disks with UDF system. The objects are shown with special Inaccessible file
icon in the List Window. You can try to recover them with the help of Scan UDF Disc command from
Tools Menu.

Apply MRW reader (default value Unchecked)
If Checked, the program automatically recognizes CD-RW disk formatted in the "Mt.Rainier" CD-RW
format (CD-MRW) placed into non-Mt.Rainier drive, and presents the data portion of the disk as a
"read only" UDF format disk. We also recommend you use this to read the disk inserted into CD-MRW
drive if your MRW disk was not ejected (closed by cd mastering program). For example, if the writing
process was interrupted by a system or power failure.
Hint. To check the drive capabilities, use Properties command applied to the "empty" drive in the List
window and select Features tab in the Properties dialog.

Display adviser window (default value Checked)
If Checked, a separate panel ("adviser") with some recommendations and results of disc analysis will
appear inside the program window.

http://www.mt-rainier.org
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A.4.2. UDF Reader

Lost objects (default value Files and folders)
Determines what objects (files and/or folders ) will be looked for by Scan UDF Disc.

Forced scan (default value Don't apply)
If the selected setting is different from the default value, the program will force the drive to scan your
CD/DVD in order to find the lost files without using the data of system area. We highly recommend you
to use this only if the inserted disk has not been recognized by CDRoller before, and you are also sure
the disk contains the files. This may be useful if the disk was incorrectly finalized and system area was
not written properly. For example, this problem often occures on Sony Mavica CD when the finalization
step failed on the camera.
If you actually know the name of CD/DVD mastering program (or device) that formatted your disk, try to
select an appropriate value from the list of the following profiles:
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Value Description

Sony Mavica CD The disk was mastered by Sony Mavica CD digital camera

Sony Mavica (O) The disk is still open (non-finalized) by Sony Mavica CD digital
camera

DirectCD CD-R CD-R was formatted by Roxio (Adaptec) DirectCD

DirectCD-RW74 CD-RW 74 min was formatted by Roxio (Adaptec) DirectCD

DirectCD-RW80 CD-RW 80 min was formatted by Roxio (Adaptec) DirectCD

InCD3     -RW74 CD-RW 74 min was formatted by Nero InCD v.3

InCD3     -RW80 CD-RW 80 min was formatted by Nero InCD v.3

PacketCD-R CD-R was formatted by CEQUADRAT PacketCD

DirectCD-MRW CD-MRW ("Mt. Rainier" CD-RW) was formatted by DirectCD

InCD3     -MRW CD-MRW ("Mt. Rainier" CD-RW) was formatted by Nero InCD v.3

PacketCD-RW CD-RW was formatted by CEQUADRAT PacketCD

InstWrite CD-RW CD-RW was formatted by VOB InstantWrite

InCD4     -RW80 CD-RW 80 min was formatted by Nero InCD v.4

InCD4  -DVD-RW DVD-RW was formatted by Nero InCD v.4

InCD4  -DVD+RW DVD+RW was formatted by Nero InCD v.4

InCD4  -MRW CD-MRW ("Mt. Rainier" CD-RW) was formatted by Nero InCD v.4

DragTo CD-RW CD-RW was formatted by Roxio Drag-To-Disc

DragTo CD-MRW CD-MRW ("Mt. Rainier" CD-RW) was formatted by Roxio Drag-To-

DragTo DVD-RW DVD-RW was formatted by Roxio Drag-To-Disc

DragTo DVD+RW DVD+RW was formatted by Roxio Drag-To-Disc

DragTo DVD-R DVD-R was formatted by Roxio Drag-To-Disc

DragTo DVD+R DVD+R was formatted by Roxio Drag-To-Disc

LiteOn DVD+R DVD+R was mastering by LiteOn DVD recorder

LiteOn DVD+R (O) DVD+R is still open (non-finalized) by LiteOn DVD recorder

Hitachi DVD-R (F) DVD-R was created and finalized by Hitachi DVD camcorder

Hitachi DVD-R (O) DVD-R is still open (non-finalized) by Hitachi DVD camcorder

Hitachi DVD-RAM DVD-RAM was mastering by Hitachi DVD camcorder

Rec DVD+RW (F) DVD+RW was created and finalized by standalone DVD Recorder
(Thomson RCA, Philips, etc.)

Rec DVD+RW (O) DVD+RW is still open (non-finalized) by standalone DVD
Recorder (Thomson RCA, Philips, etc.)

Rec DVD-RAM DVD-RAM disc was mastering by standalone DVD recorder

Rec DVD-RAM (E) DVD-RAM disc was quick-erased by standalone recorder (e.g
Panasonic DVD-RAM recorder)

http://www.mt-rainier.org
http://www.mt-rainier.org
http://www.mt-rainier.org
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Sanyo DVD+R (F) DVD+R was created and finalized by Sanyo DVD+R/RW standalone
recorder

Sanyo DVD+R (O) DVD+R is still open (non-finalized) by Sanyo DVD+R/RW
standalone recorder

Sony DVD-R (O) DVD-R is still open (non-finalized) by SONY DVD Camcorder

Sony DVD-RW (O) DVD-RW is still open (non-finalized) by SONY DVD Camcorder

Sony DVD201-RW DVD-RW disc was created by Sony DCR-DVD201 camcorder

DragTo DVD-RAM DVD-RAM disc (4.7GB) was formatted by Roxio Drag-To-Disc

B's CLiP DVD-RW DVD-RW disc was formatted by BHA B's CLip Software

B's CLiP DVD+RW DVD+RW disc was formatted by BHA B's CLip Software

Sony abCD CD-RW CD-RW disc was formatted by Sony Vaio abCD software

Pan Rec DVD-R (O) DVD-R disc is still open (non-finalized) by Panasonic standalone
recorder

InCD4.3 CD-RW CD-RW was formatted by Nero InCD v.4.3 or 5

InCD4.3 CD-MRW CD-MRW ("Mt. Rainier" CD-RW) was formatted by Nero
InCD v.4.3 or 5

InCD4.3 DVD-RAM DVD-RAM was formatted by Nero InCD v.4.3 or 5

InCD4.3 DVD-RW DVD-RW was formatted by Nero InCD v.4.3 or 5

InCD4.3 DVD+RW DVD+RW was formatted by Nero InCD v.4.3 or 5

DragTo7 CD-R CD-R was formatted by Roxio Drag-To-Disc v.7 (7.5 or 8)

DragTo7 CD-RW CD-RW was formatted by Roxio Drag-To-Disc v.7 (7.5 or 8)

DragTo7 CD-MRW CD-MRW ("Mt. Rainier" CD-RW) was formatted by Roxio Drag-To-
Disc v.7 (7.5 or 8)

DragTo7 DVD-RW DVD-RW was formatted by Roxio Drag-To-Disc v.7 (7.5 or 8)

DragTo7 DVD+RW DVD+RW was formatted by Roxio Drag-To-Disc v.7 (7.5 or 8)

DragTo7 DVD+R DVD+R was formatted by Roxio Drag-To-Disc v.7 (7.5 or 8)

DragTo7 DVD-RAM DVD-RAM disc (4.7GB) was formatted by Roxio Drag-To-Disc v.7
(7.5 or 8)

Warning. Please use the forced scan at your own risk. There is no 100% guarantee to retrieve all files
from all disks in all cases. Please keep in mind, that some files may be incorrectly written, erased or
partially re-written by a new ones.

Unpack files after forced scan (default value Unchecked)
If Checked, the program will try to decode the files found by the forced scan on the disks compressed
by Roxio (Adaptec) DirectCD. The found files can be recovered with the help of Recover All, Recover
Selected or drag & drop commands in the "Lost objects detected..." window.
Hint. AIDEX RunTime decoder (aidex.dll) must be assigned in the Path to external decoder (DLL) to
unpack compressed files.

Load Table Of Contents from file (default value Unchecked)

http://www.mt-rainier.org
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If Checked, you are prompted to select a file with the table of contents of the objects found by
Scan UDF Disc before, instead of new scan of your disk.

Always try to identify file type (default value Checked)
If Checked, the program will try to identify the types of found files at the scan stage (preliminary
identification). On some discs and drives this may slow the scan process.

Apply DVD Reader (default value Checked)
If Checked, the program will try to recognize and verify DVD disk automatically. However, in some
circumstances, for example when the disk is extremely corrupted, it is more useful to present DVD disk
as a "read only" UDF format CD. If Unchecked, only CD identification methods will be applied.

Search of all VATs (default value Unchecked)
Virtual Allocation Table (VAT) is an important part of the UDF File System. VAT's location is crucial for
CD-R/DVD-R/DVD+R disks created with the help of drag & drop software, such as well-known Roxio
(Adaptec) DirectCD and Drag-To-Disc. If the VAT can not be found or is corrupted, files will be
missing.

If the option is Checked, the program will try to search all VATs. This may give you a chance to find
and recover the files from the previous backups, including the files accidently deleted by drag & drop
software. If some old VATs are found, the program displayes their files and folders in a separate
sessions. Further, all sessions can be viewed by the built-in Session Selector.

Always check file integrity (default value Checked)
When Checked  the program always test the file before decompression, using the data of file header. If
an important file data seem to not be recovered, try to uncheck this option. Please keep in mind that
you may get an unpredictable results, so try this only at your own risk.

Always read Full TOC (default value Checked)
Try to uncheck  this box if CDRoller seems to hang up your system when analyzing the disc. This
problem can be caused by DVD43 driver installed in your system. This driver is bundled with some
DVD programs (DVD Idle Pro or DVD Region), and can prevent a normal work of CDRoller.
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A.4.3. ISO Reader

Read Path Table (default value Big Endian (Motorola)
By default, the program does use the Path Table because this is the most fast method to access the
directories on your ISO 9660 CD. CDRoller uses the Big Endian addresses by default, because
Windows doesn't use them, so CDRoller offers an alternative method at once, if your CD is not visible
by Windows. However, for a particular disc, if the default settings doesn't work properly, you can try
another settings. For example, if the Path Table seems to be invalid, you can select Don't use path
table. This will force CDRoller to start from the Root directory and scan all directories on the CD.

Apply forced scan if Path Table is invalid (default value Checked)
If Checked, the program will automatically scan the directories in case of inaccessible Path Table.

Ignore Joliet file system (use only ISO 9660) (default value Unchecked)
If Checked, any Joliet directory information on the disc will be ignored and only the ISO-9660 directory
will be displayed. This may be useful if the Joliet directory information is corrupted and the CD files
seem to be inaccessible. With the help of ISO-9660 directories you can try to access the files data,
bypassing the Joliet file system.
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A.4.4. CD/DVD Library

Apply To CD/DVD Images , group of options :
  - "Open" (default value Checked);
  - "Send" (default value Checked);
When Checked  the program tries to perform appropriate command for CD(DVD) image. If there is no
disk inserted  into CD/DVD drive, the program prompts you to insert the disk to perform Files Open and
Files Copying.

File Name (default value by Volume Name)
The File Name can be created either by choosing the Disk Volume Name (by Volume Name mode) or
summarizing the word 'CDIM' with four random digits (Random mode) or inputting CD(DVD) Image file
name manually (Manual mode).

When a new disc is inserted (default value Unhecked)
When Checked  the program creates CD/DVD Image for a newly inserted disc.

Directory for CD/DVD Images (program directory path by default)
Assigns the directory on your HDD to store created CD/DVD Images.

Directory for Temporary Storage (default value Windows Temporary Directory)
Assigns the directory on your HDD to be used as Temporary Storage for drag-and-drop and Files
Open.

Warning. Please do not select "Directory for Temporary Storage" as destination folder for Recover
All and Recover Selected operations. When you close CDRoller, the program automatically cleans
out this temporary folder, and all recovered files and subfolders will be lost!
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A.4.5. Audio Extraction

DAE Method (default value Dynamic Sync Width)
By the Dynamic Sync Width method the program tries to synchronize new audio data with the
previously read block of audio sectors by changing the overlap area between two consecutive read
blocks. Fixed Sync Width  means that a set amount of frames is used for blocks synchronization.
Read error detection and lost synchronization control also occure in both methods. The audio
extraction by Burst Copying method is the fastest. Burst copy doesn't use any synchronization and
error recovering.

Read Command (default value AUTODETECT)
If AUTODETECT (recommended setting) option has been selected, the program tries itself to find an
appropriate read algorithm for user's CD drive.
SCSI READ CD function is the base command recommended by SCSI-3 Standard for reading audio
frames. It is supported by all ATAPI drives that have DAE feature, and some SCSI devices.
SCSI READ (10) function may be used for DAE on SCSI drives support SCSI-2 Standard.
Note. The list of audio read commands used by program in AUTODETECT  mode is not limited by two
ones mentioned above. Some known read functions are absent in the selection list because a wrong
chosen extraction command may cause problems on some SCSI systems.

Swap Channels (default value Unchecked)
When checked, the program itself will exchange left and right channels in the audio samples before
writing them into output file. This may be suitable for some CD drives to exchange stereo channels
while extraction.
"Big Endian" (default value Unchecked)
Motorola " Big Endian" mode is often used on drives from Grundig, IMS, Kodak, Ricoh and some
others.
WARNING. Check this option only if the extracted output file seems to consist of noise!

Wave Format (default value 44,100 Hz; 16 Bit; Stereo)
Indicates a brief description of audio compression format that has been selected.
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Select Encoder (default value Internal WAV)
Assigns an appropriate encoder from the list of available ones.

File extension (default value .wav)
Indicates the extension of output file (.wav, .mp3 or .raw).

Options
Activates an options dialog box to select audio compression format.

High Quality (default value Unchecked)
For some audio compression formats, specifying this flag might improve the audio quality or other
characteristics.

A.4.6. Disc Test

File System Test group.
Show the details of "import" file (default value Checked)
For multisession discs only. When Checked, a report window displays some info whether a file was
imported from the prior session ("came from session # ..."), or not.
Include to Disc Test (default value Checked)
When Checked  File System Test will be included to the list of available tests.
Check on the disc (default value All available sessions)
If All available sessions option has been selected the program checks file systems of all sessions on
multisession disc. In case of Selected session only  the selected session is examined.
Note. There is no difference between these two settings for single session disc.

Disc Surface Test group.
Scan ratio Track Bar (default position 20 to 2000 sectors )
Sets the current ratio of read sectors to total sectors in the block. For example, "20 to 2000 sectors"
setting means that the program reads 20 sectors in the block of 2000 sectors and therefore, then skips



Annex A   Controls and dialog boxes. 53

© 2003 - 2007 Digital Atlantic Corp.

(2000 - 20) sectors before the next reading. This setting is used for Disc Surface Test and also for
DAE Quality test.
Include to Disc Test (default value Unchecked)
When Checked  Disc Surface Test is included to the list of available tests. For mixed CDs it means that
as Disc Surface Test as DAE Quality test will be included to the list of available tests.
Check on the disc (default value All available sessions)
If All available sessions option has been selected the program scans disc surface on all sessions. In
case of Selected session only the selected session is examined on multisession disc.

Note. There is no difference between these two settings for single session disc.
Audio Read Overlap (default and minimum values are 0, maximum value is 7)
Sets the number of overlapping sectors for DAE Quality test. This may be useful to determine the value
of overlap for so-called "jitter correction" while reading CD audio data.
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Annex B  License Agreement

CDRoller - End User License Agreement (EULA).

YOU SHOULD CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT. USE OF THE
SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES YOUR
ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE. USER'S USE OF THIS
SOFTWARE IS CONDITIONED UPON COMPLIANCE BY USER WITH THE TERMS OF THIS
AGREEMENT.

1. LICENSE GRANT.
Digital Atlantic Corp. grants you a license to use one copy of the version of this SOFTWARE on any
one hardware product for as many licenses as you purchase. "You" means the company, entity or
individual whose funds are used to pay the license fee. "Use" means storing, loading, installing,
executing or displaying the SOFTWARE. You may not modify the SOFTWARE or disable any licensing
or control features of the SOFTWARE except as an intended part of the SOFTWARE's programming
features. When you first obtain a copy of the SOFTWARE, you are granted an evaluation period of not
more than 14 days, after which time you must pay for the SOFTWARE according to the terms and
prices discussed in the SOFTWARE's documentation, or you must remove the SOFTWARE from your
computer. This license is not transferable to another company, entity, or individual.

2. OWNERSHIP.
The SOFTWARE is owned and copyrighted by Digital Atlantic Corp. Your license confers no title or
ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

3. COPYRIGHT.
The SOFTWARE is protected by United States copyright law and international treaty provisions. You
acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You
further acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive
property of Digital Atlantic Corp. and you will not acquire any rights to the SOFTWARE except as
expressly set forth in this license. You agree that any copies of the SOFTWARE will contain the same
proprietary notices which appear on and in the SOFTWARE.

4. UNAUTHORIZED USE.
You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer,
or transfer the SOFTWARE except as provided in this agreement. Any such unauthorized use shall
result in immediate and automatic termination of this license.

5. DISTRIBUTION.
Permission to distribute the SOFTWARE is not transferable, assignable, saleable, or franchisable.
Each entity wishing to distribute the package must independently satisfy the terms of the distribution
license. All distribution of SOFTWARE is further restricted with regard to sources which also distribute
virus source code and related virus construction/creation materials. The SOFTWARE may not be
made available on any site, CD-ROM, or with any package which makes available or contains viruses,
virus source code, virus construction programs, or virus creation material.

6. WARRANTY.
THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. DIGITAL ATLANTIC CORP. DISCLAIMS
ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NEITHER DIGITAL ATLANTIC CORP. NOR ANYONE
ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS
SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE, EVEN IF
DIGITAL ATLANTIC CORP. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR
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CLAIMS. THE PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND
PERFORMANCE OF THE SOFTWARE. SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR
EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
OR EXCLUSION MAY NOT APPLY TO YOU TO THE EXTENT THAT LIABILITY IS BY LAW
INCAPABLE OF EXCLUSION OR RESTRICTION.IN NO EVENT SHALL ANY THEORY OF
LIABILITY EXCEED THE LICENSE FEE PAID TO DIGITAL ATLANTIC CORP.

7. SEVERABILITY.
In the event of invalidity of any provision of this license, the parties agree that such invalidity shall not
affect the validity of the remaining portions of this license.

8. LIABILITY.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL DIGITAL ATLANTIC
CORP. OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL,
INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY,
PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF DIGITAL ATLANTIC CORP. HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL DIGITAL ATLANTIC
CORP.'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY
OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU,IF ANY.

9. INSPECTION AND TESTING.
You agree and acknowledge that you will thoroughly inspect and test the SOFTWARE for all of your
purposes upon commencement of your use. Any suit or other legal action, claim or any arbitration
relating in any way to this agreement or software covered by it must be officially filed or officially
commenced no later than Three months (90 days) after your first use of the software.

10. ENTIRE AGREEMENT.
This is the entire agreement between you and Digital Atlantic Corp. which supersedes any prior
agreement or understanding, whether written or oral, relating to the subject matter of this license.

11. RESERVED RIGHTS. All rights not expressly granted here are reserved to Digital Atlantic Corp.
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